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Chapter 1

INTRODUCTION

Topographic map is an important prerequisite for Agricultural Engineers as their sphere of
activities include soil and water conservation, design and execution of irrigation systems, drainage
network, location decisions of farm infrastructures, local and regional agricultural planning
among other things. Areas of the land parcel, relative elevation, nature of the terrain and land use
are the important information that a topographic map generally will provide. Among the various
applications of topographic maps in Agricultural Engineering, soil and water conservation may be
the most important item. When the area involved is large, planning of water harvesting, erosion

control etc. will be made on a map and later on those will be transferred to the field.

Soil, the weathered portion of earth crust, is one of the most important natural resources that
support all forms of life on earth. Conservation of this resource assumes great significance as it is
very much prone to various types of soil erosion processes such as wind and water erosion. Soil
erosion is defined as the detachment, transportation and deposition of soil particles from one
region to another under the influence of erosive agents. According to estimates by ICAR, the loss
due to water erosion is 53.34 million ha annually. The erosion status of the state reveals that
83500 ha is severely eroded, 973245 ha is moderately eroded, 1064879 ha is moderately to
slightly eroded, 307708 ha is slightly eroded and 620965 ha is under permanent vegetation and is
well protected. Soil erosion process is influenced by a number of factors. Land slope and climate
are the two important factors governing the rate of soil erosion. In a humid climate with
undulating terrain, any agricultural activity should be preceded by soil erosion control measures.
Susceptibility of soil erosion depends upon the nature of the soil and the topographic factors. To
plan soil erosion control measures, estimating the erosion potential of different land parcels are
very essential. A topographic map of the area is the primary pre-requisite of soil erosion studies

and for planning any other agricultural infrastructures.

A topographic survey is the means of producing a topographic map. The preparation of
topographic map can be done by means of theodolite, aerial photography, Total Station, GNSS
etc. High accuracy, efficiency and less time requirement give more predominance and acceptance
to Total Station and GNSS. Theodolite and other conventional surveying techniques are very slow
and laborious and practically not feasible for a large area. Total station surveying is advancement
to theodolite surveying. Many field operations such as angle and distance measuring and their
field recording have been automated in Total Station surveying.
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Total Station surveying is defined as the use of electronic survey equipment used to perform
horizontal and vertical measurements in reference to a grid system. Total Station is a form of an
electronic theodolite combined with an electronic distance measuring device (EDM). Its primary
function is to measure slope distance, vertical angle, and horizontal angle from a setup point
called instrument station to a foresight point. Most Total Stations use a modulated near infrared
light emitting diode which sends a beam from the instrument to a prism. The prism reflects this
beam back to the instrument .The portion of wavelength that leaves the instrument and returns is
assessed and calculated. Distance measurements can be related to this measurement using the
principle of travel of light energy through air. Angle accuracy can range from 2’ to 5. Distance
accuracy can range from +/- (0.8+1ppm* D) mm to +/- (3+3ppm* D) mm, where D is the distance

measured.

Some of the advantages of Total Station surveying are:
e Reduce error: Manual errors involved in reading and recording can be eliminated.
e Time saving: Field work is carried out very fast.
e Accuracy of measurement is high.
e Precision data.
e Calculation of coordinates is very fast and accurate. Even corrections for temperature and
pressure are automatically made.
e Computers can be employed for map making and plotting contour and cross section.

Contour intervals and scales can be changed at any time.

DGPS (Differential Global Positioning System) is an advanced version or the enhancement to
Global positioning System or the GPS. DGPS provides better and improved location accuracy
than GPS from a nominal GPS accuracy of 15 meters to that in the best implementation of about
10 cm. It increases the accuracy of the locations or the coordinates derived from the GPS
receivers. The principle behind DGPS is to use the reference location of the base receiver to
correct for the location error of the unknown rover position. Since the base station is fixed, we
can use the difference between the measurement of the base and the rover receivers to create an
error correction vector. The precise location of the rover can then be calculated if we apply the
error correction over all the satellite data. DGPS can be achieved through real-time telemetry links
between a base and a rover or through post-processing the data. DGPS application include
topographic surveys, control establishment and densification, positions, lines and levels setting

out, azimuth determination and collar pick-ups (X; y; z).



Advantages of DGPS are:

e Use of DGPS increases the accuracy (+/-0.045m)
e Real time data

e Worldwide coverage

e 3D survey results

e 24 hours availability

Disadvantages of DGPS are:

e Most of the errors are completely eliminated or made negligible, however atmospheric
errors are RX based errors would still exist. DGPS error sources are satellite clocks,
orbital error, ionosphere, troposphere, RX noise and multipath.

e The coverage area to take advantage is limited.

e To ensure greater coverage area more DGPS stations need to be added.

In this context, an attempt has been made in this project work to prepare a topographic map using

Total Station and DGPS to facilitate erosion studies with given below specific objectives:

e To study the principle and operations of Total Station and GNSS
e To prepare a topographic map of KCAET campus using Total Station and DGPS

e To prepare a land slope map from topographic map for erosion studies.
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Chapter 2
REVIEW OF LITERATURE

A critical review of some of the important research work done in the area of topographic

surveying using total station, GNSS and soil erosion studies are presented in this chapter.

Colosi et al. (2000) carried out a series of topographical surveys in the Salto Valley (Rieti -Lazio)
and provided much interesting data regarding local archaeological sites, particularly along the
southern slopes of the Breccioso Hills which rise between the Corvaro and Spedino plain. The
nature of the site was not clear and its structure is hazy, as a result of the deterioration of the
surrounding ground and increased vegetation coverage. So a detailed survey of the southern
incline and the plateau associated with the site was suggested. The objective of the survey was to
highlight topographic variation and to bring to light any traces of human construction or
manipulation. The survey was carried out using a DGPS Leica SR 510, and a Total Station. The
integration of these two instruments produced satisfactory and innovative results. The processing
of the Digital Terrain Model (DTM) of the area highlighted several characteristics of the site and

the consequent production of thematic maps from this data were done.

Jeyapalan and Bhagawati (2000) conducted a study on Total Station, Differential Global
Positioning System (DGPS), Videologging, soft photogrammetric and virtual reality methods of
collecting data on road side features of urban, city and rural roads for creating a Geographic
Information System (GIS). The first 15 highest priority road side features were: intersections,
signs, pavement markings, signals, curbs, guard rail, number of lanes, rail road crossings,
shoulders, side walk, road names, pavement distress, roadway geometric, bridges and Right of
way. The videologging system gives the digital image and the X, Y, Z coordinates of the camera
locations, using this information and soft photogrammetry it is possible to determine the location
of any feature. Virtual reality is the mode in which a user can view in 3D, fly through the virtual
model, modify in real time and view or measure its effect. The conclusion of the study was, Total
Station can be used to collect data for creating 2D GIS showing roadside features at a scale of
11=25" or larger and or smaller. DGPS can be used for mapping at scale 1! = 50" or smaller. Both
systems are time consuming in the field. Soft Photogrammetry with digital videologging imagery
can be used to map roadside features at 1! = 25" or smaller. It saves field data collection time;

however, it requires calibration and stereo data collection time in the office.



Casasnovaset al. (2001) developed a method that can be used to quantify and map soil losses at
field scale produced by extreme rainfall events. The amounts of sediment produced by overland
flow and concentrated overland flow (inter-rill, rill and gully erosion)at the agricultural plot scale
are evaluated from elevation differences computed from very high resolution digital elevation
models (DEMSs) , from data obtained before and just after an extreme rainfall event. Multi-
temporal spatial data are analysed by GIS techniques. A mechanised vineyard plot located in the
Alt Penedes—Anoia region (Catalonia, Spain) is used as the reference for case study. According to
the obtained data the rainfall event, which occurred in June 2000, registered 215 mm, 205 mm of
which fell in 2 h 15 min. The average intensity of the downpour was 91.8 mm/h, with a maximum
intensity in 30-min periods of up to 170 mm/h. The erosivity index R reached a value of 11,756
MJ/ha mm/h, 10 times greater than the annual value for this area. The volume of soil detached by
the rainfall, as measured by the proposed method, was 82819 m®. About 57% of the detached soil
particles were deposited with in the same plot. The balance was negative, with a total 35236 m® of
soil loss from the plot, which represented a rate of 20721 Mg/ha. The paper analyses the
characteristics of the rainfall event in relation to historical data and discusses the proposed method
for soil erosion mapping at plot scales in relation to other measurement methods.

Agrawal R et al. (2006) have validated SRTM DEM with differential GPS measurements in this
study. It deals with the accuracy assessment of the interferometric terrain evaluation data (DEM)
from SRTM mission. The data was compared with reference to ground control points of
differential GPS measurements at three different types of terrains (ranging from plain, moderately
undulating and hilly region). Since the SRTM elevation values are orthometric height values in
WGS84 datum, for the purpose comparing with DGPS co-ordinate were converted to WGS84
ellipsoidal value using EGM96 geoidal height model. The error statistics was generated between
DGPS measurements and SRTM WGS84 ellipsoidal heights. It was observed that for the plain
area like Ahmedabad (Gujarat) the errors were quite small (3.55m) ,whereas in the cases of
moderately and hilly terrain like Alwar (Rajasthan) and Chamoli (Uttaranchal) the RMS errors
were of the order of 11.44m and 19.64 m respectively. It is concluded that SRTM DEM can be
used for any application depending upon the accuracy demand.

Ehioroboa and lzinyona (2006) located the position of all major rills and gully sites and
georeferenced them using hand held GPS receiver. Based on severity rating and geopolitical
considerations, six of the erosion gully sites were selected for monitoring. Control points were

established around each of the gully sites by method of Differential GPS (DGPS) surveys and

7



detailed topographical survey of gully sites were carried out using reflectorless Total Station
instruments. In combination with GIS and Total Station data SPOT imageries were used and
location maps, contour maps along with DEM were generated using ARCGIS 9.2 software. The
morphological parameters of the gullies were then determined. Volumetric estimate of the amount
of soil loss from gully erosion was also carried out. Soil samples recovered from the gully sites
were used to determine their erosivity and other properties to be used for soil loss modelling. The
results of the studies were used as an indicator for determining the gully initiation point, slope-
area relationship, and threshold of gully initiation was also established. The minimum AS2 value
was 345 while the maximum was 3,267. This shows that the results lie within the two boundary
layers of 41 and 814 (m?) and 500-4000 m? established by Poesen et al.

JUNG Rea Jung (2006) studied the method of DGPS applications for the cadastral surveying in
Korea. A DGPS beacon system was implemented at the coastal area for the marine ship
navigation purpose. The study focused on suggesting the practical possibility of DGPS in the
cadastral survey. For this, several field tests were conducted. It was found that the accuracy in
horizontal components averages 74 cm in the readjustment of arable land and 228cm in the forest.
In the forest, the rate of Differential GPS Fix of Beacon DGPS was low and HDOP (Horizontal
Dilution of Precision) was high. It was also found that DGPS doesn't cover the cadastral boundary
surveying, however it will be expected that possibility to play a role as a part of device for the
ubiquitous cadastre, such as finding control points and boundary points, connected with PDA,
RFID on the site could be obtained. And also, this study showed that DGPS will be applicable for
high-precision-position-based services like LBS (Location Based Service), and ubiquitous

cadastral surveying.

Rodriguezet al. (2006) conducted a study on comparison of GPS receiver accuracy and precision
in forest environments and practical recommendations regarding methods and receiver selection.
This study compares recreational GPS receivers (GARMIN eTrex Euro, GARMIN 12XL,
GARMIN Summit, GARMIN Geko 201)and more precise GPS receivers (Topcon Hiper+). It was
aimed to determine the most suitable method and receiver for position assessment under different
forest canopy covers, in terms of easiness of use, accuracy, reliability, and the ratio accuracy/cost.
Several positioning techniques were compared: autonomous, real-time differential, and post-
processed differential modes, as well as the effect of using an augmentation system. The test
course consisted of 19 points sited under different tree canopies and one point without any
obstacle. Test procedure was identical for all twenty points, days and receivers. GPS positioning

was repeated five times at each test point using, twenty minutes before receivers were turned on.
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Results showed that there were significant differences between the receivers regarding accuracy
and precision measuring coordinates; moreover, accuracies were different depending on the
canopy cover and forest characteristics. Therefore, practical recommendations for each case were
settled in order to help foresters to select the most suitable receiver.

Filjar et al. (2007) studied the DGPS Positioning Accuracy for LBS (location based services).This
study was based on experimental data analysis. A vehicle was equipped with two Garmin
GPSIII+ receivers, one working in standard and the other in differential GPS positioning mode.
Differential GPS corrections were delivered from the Prague differential station through the
EUREF-IP network and using the mobile Internet GPRS connection. Additional software was
developed inorder to support both the NMEA-0183 acquisition and the DGPS corrections delivery
using the same serial port for GPS receiver running in differential GPS mode. Every positioning
sample consists of: GPS time of sampling, Latitude, Longitude, Horizontal positioning error
estimate (calculated by GPS receiver), and Number of visible satellites. The conclusion of the
study was Differential GPS positioning improves the LBS positioning performance, compared
with the standard (un-assisted and un-augmented) GPS positioning. However, general LBS
positioning accuracy still cannot be improved in a way that would satisfy high-level requirements

by deployment of differential GPS positioning alone.

Hayakawa et al. (2007) conducted an accuracy assessment of a post processing differential GPS
device. Here they used a portable DGPS device, Mobile mapper pro by Magellan Navigation Inc.
This DGPS device is capable of differential correction of GPS signals by two means; real-time
SBAS (Satellite-Based Augmentation System) correction (2-3 m accuracy) and post processing
correction (1m accuracy). At Kaman, the measurements were taken with a relatively short
duration; 131 measurements in one day. At Hacitugrul, measurements were taken with a relatively
long duration; 114 measurements over 10 days. After the field measurements, the DGPS data
were imported into a PC via SD memory card, and the DGPS log data of the base and mobile
devices were post processed using bundled software (mobile mapper office). It was found that 2
minutes is the minimum necessary time to enable efficient post processing differential correction
for the DGPS device used. The position accuracy of SBAS based differential correction is several

meters, even when the measurements are taken over a period as long as 6 hours.

Mottershead et al. (2007) surveyed small scale terrains on salt materials with a Total Station and a

series of digital elevation models (DEMSs) constructed. Eight months apart two sets of
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observations were made, during which the terrains underwent significant erosion. The difference
in elevation shown by the DEMs is a measure of surface erosion of the salt terrains. The erosion
rate was analysed with respect to four terrain parameters calculated in the software. High erosion
rates, and their strong control by terrain slope, are demonstrated, supporting an earlier study using
erosion pins. Indications show that slope profile curvature is also having some influence. The
combination of scanning Total Station and DEM software is found to be an effective tool for

investigating rapid geomorphic change at this scale of study.

Baptista et al. (2008) conducted a DGPS survey on beach profiles using a DGPS mounted on a
vehicle and a traditional pole-mounted DGPS. A vehicle mounted DGPS provided a highly
accurate non time consuming measurement campaign (easily repeated). Measurements were taken
using a pole-mounted DGPS in areas where the vehicle could not reach. The area surveyed was
approximately 10,000m?. A mesh measurement regime was used since beach profiles have
relatively smooth features. Profile features should be the base for profile mesh size used. The
volumes of points are represented by the amount of morphological change in the survey site. Due
to increased elevation variability in the site, it requires more measurement points than a smoother
site. Very high resolution meshes may not significantly improve the quality of a DEM and a mesh
too wide will not pick up the topographic features in a site. In this study, when different mesh

sizes were analysed, the highest density mesh provided the best results.

Rayburg et al. (2009) assessed the quality of DEMs derived from LIiDAR, DGPS and spot heights
taken from a 1:100,000 topographic map. The area studied was Narran Lake Ecosystem in north
western New South Wales, Australia. The DGPS survey done consisted of 20,000 points having a
spatial resolution of approximately 1m along survey lines and 200m between survey lines. LIDAR
survey consisted of approximately 650,000,000 data points, with a spatial resolution of 1m? and a
vertical accuracy of 8 - 11cm. All DEMs were created using the kriging interpolation model. The
LiDAR-derived DEM represented a wide range of topographic features and the DGPS-derived
DEM gave considerably less details, but in some areas they gave similar results to the LiDAR.
LiDAR- and DGPS-derived DEMs differ by a minimum of 25cm and maximum of several metres
in areas. DGPS-derived DEM s of varying quality as considerable fewer points were measured
compared to the LIDAR survey. This limitation was mainly due to the challenges associated with
ground surveying, as the terrain was difficult to navigate. The LiDAR-derived DEM provided the
best results. This resulted in the representation of more features including macro- and micro-

channels, flood plains, clay pans, sand dunes, and subtle variations in lake topography.
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Dattaand Kirchner (2010) used a digital elevation model (DEM) to derive the topographical
characteristics of a study area. Usually, a DEM is incorporated into erosion models as a given
parameter and it is not tested as extensively as the parameters related to soil, land-use and climate.
In this study, they compares the erosion relevant topographical parameters (elevation, slope,
aspect, LS factor) derived from 3 DEMs at original and 20 m interpolated resolution with field
measurements for a 13 km? watershed located in the Indian Lesser Himalaya. The DEMs are: a
TOPO DEM generated from digitized contour lines on a 1:50,000 topographic map; a Shuttle
Radar Topography Mission (SRTM) DEM at 90-m resolution; and an Advanced Spaceborne
Thermal Emission and Reflection Radiometer (ASTER) DEM at 15-m resolution. ASTER DEM
was found to be poorest whereas, TOPODEM produced similar results to the coarser SRTM
DEM, but failed to produce an improved representation of the watershed topography. Comparison
with field measurements and mixed regression modelling proved SRTM DEM to be the most

reliable among the tested DEMs for the studied watershed.

Ortiz et al. (2010) have done comparison of regional elevation heights in the Aguascalientes basin
using DGPS technique with INEGI’s digital terrain model. The purpose of this paper is to
compare DGPS surveys using both two and three receivers, and to determine the error bar
between the DTM (Digital Terrain Model) and the DGPS technique using as an example the city
of Aguascalientes and surroundings. Two base receivers (Trimble 5700), and one portable
receiver (Trimble 5800) were used. From this control point, elevations of the other benchmarks
were determined using the TGO software. The research presented here shows that if adequate
satellite coverage is available, two DGPS receivers generate an acceptable DTM model for the
area under study. Three receivers give redundant information and allow the user to close the
polygons offering increased confidence on the measured values. DTM models are an
approximation and may be used as an initial value. Based on the results presented here, they
suggest that DTM’s may only be used for regional studies, and cannot be used to estimate the

hydraulic gradient in aquifers in Mexico.

Smuleac et al. (2010) used the Leica TPC 805 Total Station for the topographic and land survey
measurements, and the data were downloaded with LEICA Geo Office Tools special software.
The following plans were executed after the measurements were taken: dimension site plan -
1:500; plot plan - 1:1000; development site plan - 1:10000. Generally, a geodesic network has at
least two old points that in the first stage help determine the coordinates of the "new" points with

the help of a certain method. A direct link is created between the older points through horizontal
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angular observations. Distances and orientation must also be determined between these points and
they will be used in the compensation calculations. The calculations of the geo-topographic
support networks were done with the TOTAL 2.0 software. The compensation of the support
network is done with the least squares method, the indirect measurement method. The software
creates a DXF file that can be used with the AutoCAD package at a later time. TOTAL 2.0
calculates and, where necessary, compensates any combination of direction and distance
measurements, from the easiest (cancellation of registration, multiple intersection, multiple

resection) to the most complex ones (various traverses, polygonometric networks, triangulation).

Connemara et al. (2011) carried out topographic survey at four historic bridges. Site survey
control was established using a Trimble Differential GPS (R6). Subsequent surveying was carried
out using both a Total Station (Leica TCR 407, Penmap Software, and Panasonic Toughbook
Tablet PC) and a Trimble Differential GPS (R6). The survey data was edited in AutoCAD to
create a hachured ground plan and a single representative elevation drawing. The four bridges
were surveyed in three dimensions and the majority of the ground plan and topographical details
were collected using the Trimble Differential GPS (R6) and supplemented with the Total Station
and detail pole where necessary due to poor GPS signal. So majority of the elevation data were

collected by means of the Total Station’s red laser feature.

Jeonget al. (2013) conducted accuracy and efficiency tests for four different beach-profile
surveying methods of: (i) spot measurement using a Total Station; (ii) spot measurement using a
RTK-GPS system; (iii) continuous walking measurement using a RTK- GPS backpack system;
and (iv) continuous measurement using a RTK-GPS system mounted on an all-terrain vehicle
(RTK-GPS ATV system) at the Gosapo macro-tidal sand beach, South Korea. The test results
indicates that the RTK-GPS spot measurement method have the lowest vertical error of about 2
cm, which includes equipment and operation errors, while the rest of them have similar vertical
errors with a range of 3 to 6 cm. Compared to other surveying methods, RTK-GPS ATV system
have advantages in surveying time and operational manpower with a reasonable vertical error of
about 3 cm, which increases their surveying efficiency. As a result, The RTK-GPS ATV system is
the most suitable surveying method for examining the beach volume and morphologic changes in
a macrotidal sand beach, while the spot measurement methods using the Total Station or the

RTK-GPS system are adequate for accurate beach profile change.
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Pradeep Kumar et al. (2013) made an attempt to assess the accuracy of DGPS by comparing the
data obtained from the Total Station at Indian School of Mines, Dhanbad campus. With DGPS the
maximum error of 0.013m, minimum error of 0.002m and average error of 0.004m with standard
deviation of 0.00554m was observed in Northing. In Easting maximum error of 0.017m,
minimum error of zero meters and average error of 0.005m with standard deviation of 0.00674m
was observed. The maximum error of 0.027m, minimum error of 0.005m and average error
0.007m with standard deviation of 0.01526m was observed in Reduced Level. The variation of
average area from DGPS data with reference to Total Station data is 1.058m?. The DGPS provides
the more reliable and accurate data which can be used for medium to small scale maps. The
accuracy of data became improved with repeated observations and it depends on the taking of
averages of data.

Ragab Khalil (2013) studied the accuracy of GIS tools for transforming assumed total station
surveys to real world coordinates. In this paper the effect of using Georeferencing tool, Spatial
Adjustment tool (Affine and similarity) and CHaMP tool on the precision and relative accuracy of
total station survey were studied. The effects of using geodetic GPS, hand-held GPS, Google
Earth (GE) and Bing Base maps as sources for control points on the precision and relative
accuracy of total station survey was also studied. These effects have been tested by using 111
points from a covered area of 60,000 m? and the results have shown that the CHaMP tool was the
best tool for preserving the relative accuracy of the transformed points. The Georeferencing and
spatial adjustment tools gave the same results and their accuracy were between 1/1000 and 1/300
depending on the source of control points. The results have also shown that the cornerstone to
preserve the precision and relative accuracy of the transformed coordinates is the relative position

of the control points.

Diwakar et al. (2014) investigated the horizontal accuracy of Differential-GPS (DGPS) survey
with comparison of Total Station instrument data. In this study they investigated the effect of
observation time and the PDOP value on the accuracy obtained. The variation of accuracy with
time and PDOP value has been analysed by curve fitting technique. For this work 19 points were
established and observations were taken by using Total Station; TRIMBLE M3 and DGPS;
TRIMBLE R3. Trimble Business Centre and the GNSS solution software are used for processing
of raw data collected using DGPS. Terra Model software was used for processing Total Station

data. Distance and height between established points is calculated using Total Station instrument
13



using angle and distance method. Distance calculated for successive points from DGPS data is
compared with the distance calculated using Total Station. Afterward mean error, RMSE,
standard deviation of distance calculated from DGPS is estimated from Total Station. The
conclusion of the study was 25 minute observation time is sufficient as the accuracy in horizontal
measurement for 25 minute observation Standard deviation and Standard Error is 0.013 meter and
0.003 meter respectively. Accuracy of DGPS survey is dependent upon the observation time and
PDOP value. It is found in this study that for poor PDOP even long observation time does give
better accuracy.
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Chapter 3
MATERIALS AND METHODS

3.1 Study area

The study has been conducted in KCAET campus, Tavanur, Kerala, India having a geographical
location of 10°52°30” North latitude and 76° East longitude. The area is characterized by sloping
and undulating terrain with moderate vegetative cover. Total area comes to about 40 ha of which
50% is upland and the balance low lying paddy fields. Climate is humid tropic with an average

annual rainfall of 3000 mm.

3.2 TOTAL STATION

Total Station is an optical instrument used in modern surveying. A Total Station surveying system
consists of an electronic theodolite with an integrated Electronic Distance Measurement
Instrument (EDMI), coupled with a precision retro reflector. There are reflectorless Total Stations
available, but they tend to measure distances with a lesser degree of precision. Total Stations have
been in use by the surveying community since the 1970s and are a proven technology. Total
Stations are designed for outdoor usage and is capable of working in extreme weather conditions.
It should not be exposed to heavy precipitation. Some Total Stations have robotic capabilities,
enabling remote or programmed operations. These should be applicable to automated co-location
surveys or monitoring. The primary function of Total Station is to measure slope distance, vertical

angle, and horizontal angle from a setup point called instrument station to a foresight point.

Plate 3.1 Instrument setup
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3.2.1 Main accessories of Total Station

3.2.1.1 Tripod

The most important criterion for a good tripod is its stability, more precisely, the torsional
rigidity. Other requirements include the height stability under load and the minimal horizontal
drift, long life, optimal vibration dampening, water resistance, outstanding behavior in solar

radiation and their light weight in relation to load bearing capacity.

3.2.1.2 Tribrach

The most important criterion for a good tribrach is its good torsional rigidity or hysteresis. This
hysteresis is the relative movement between the top plate and the base plate of a tribrach that
occurs through the rotation of a TPS instrument. The hysteresis has direct influence on the angular

accuracy of the instrument.

3.2.1.3 Prism

The range of a prism results from its coating and the glass geometry. A number of original prisms
have a special coating on the reflective surfaces — the Anti-Reflex Coating, and a copper coating
on the reverse side. Without these, the range of distance measuring, ATR and power search would
be reduced by up to 30%. The workmanship and the durability of the copper coating are decisive
for a long life. The glass dimensions, the position in the holder and the spatial orientation with it
are important for measuring accuracy. Even under the most extreme environmental conditions, a
long life span and maximum range of the highest accuracy are the most important criterion for

prism.

3.2.2 Instrument Setup
3.2.2.1 Important features

* It is always recommended to shield the instrument from direct sunlight and avoid uneven

temperatures around the instrument.

* The laser plummet described in this topic is built into the vertical axis of the instrument. It

projects a red spot onto the ground, making it appreciably easier to center the instrument.

* The laser plummet cannot be used with a tribrach equipped with an optical plummet
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3.2.2.2 Tripod

When setting up the tripod, attention should be paid to ensure a horizontal position of the tripod
plate. Slight corrections of inclination can be made with the foot screws of the tribrach. Larger
corrections must be done with the tripod legs. For this, clamping screws are loosened on the

tripod legs, and the legs are pull out to the required length and the clamps are tightened.

a) In order to guarantee a firm foothold, the tripod legs have to be sufficiently pressed into the

ground.

b) When pressing the legs into the ground, it is to be noted that the force must be applied along
the legs.

Careful handling of tripod involve
* Checking of all screws and bolts for correct fit.
» Use the cover supplied while on transport.

1. Extend the tripod legs to allow for a comfortable working posture. Position the tripod over the

marked ground point, center it as best as possible.
2. Fasten the tribrach and instrument onto the tripod.

3. Turn on the instrument, and, if tilt correction is set to On, the laser plummet will be activated
automatically, and the Level & Plummet screen appears. Otherwise, press the FNC/Favourites

key from within any program and select Level &Plummet.

4. Move the tripod legs and use the tribrach footscrews to center the plummet over the ground
point.

5. Adjust the tripod legs to level the circular level.

6. By using the electronic level, turn the tribrach footscrews to precisely level the instrument

7. Centre the instrument precisely over the ground point by shifting the tribrach on the tripod
plate.

8. Repeat steps 6 and 7 until required accuracy is achieved. Use the tripod only for surveying
tasks.
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Plate 3.2 Measuring height of instrument
3.2.2.3 Electronic level
1. Turn the instrument until it is parallel to two foot screws.
2. Centre the circular level approximately by turning the foot screws of the tribrach.

3. Turn on the instrument, and, if tilt correction is set to On, the laser plummet will be activated
automatically, and the Level & Plummet screen appears. Otherwise press the FNC/Favourites
key from within any program and select Level & Plummet by turning the two foot screws.
Arrows show the direction of rotation required. The first axis is levelled, when the bubble is
exactly between the squared brackets [] of the single axis bubble tube.

a) The bubble of the electronic level and the arrows for the rotating direction of the foot screws
only appear if the instrument tilt is inside a certain leveling range.

4. Centre the electronic level of the first axis .The electronic level can be used to precisely level
up the instrument using the foot screws of the tribrach.

a) When levelled correctly, checkmarks are displayed. For the Color and Touch display only; if
the instrument is not levelled to one axis, then the icons for the single axis bubble tube and the
circular bubble are framed red, else black.

5. Centre the electronic level for the second axis by turning the last foot screw. An arrow shows
the direction of rotation required.

a) When all three bubbles are centered, the instrument has been perfectly levelled up.

6. Accept with Continue.
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3.2.3 Working with Total Station:

i. Set up the tripod and mount the instrument.

ii. Switch on the instrument.

iii. Level and center the instrument.

iv. In the main menu select Programs - Surveying->set job.

V. Press F1to create new job.

vi. Give job name = ok. Then job is set.

vii. Go to Surveying->station set up—>set job->start->orientation with angle—>coordinate
entry.

viii. Give point id and values to east, north, and height a 1000, 1000, 100 respectively.

iX. Height of the instrument is given. Horizontal angle is taken as 0 - station and orientation set.
X. Give point id, height of reflector and remarks if needed.

xi. Measure maximum number of possible points from that particular position.

xii. Determine the next station by taking into consideration the relief, accessibility and visibility
of the region.

xii. Measure the point. Note down the horizontal angle.

xiii. Change the station setup.

xiv. Select Orientation with Coordinates (Known Back Sight)
xv. Select target point id from list > coordinate entry-> give height of reflector (hr).
Xvi. Sight target point.

xvii. Note the horizontal angle. See if there is any variation in the angle. If there is difference in

the values, then repeat the above steps. If there is no error set the point by pressing Set.
xviii. Next a window opens asking HO already exists-> select old - station and orientation
set.

xix. Continue the survey.
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Plate 3.3 Working with TS

3.2.4 Exporting of data

Job data, format files, configuration sets and code lists can be exported from the internal memory
of the instrument. Data can be exported via:

e The RS232 serial interface
A receiver, such as a laptop, is connected to the RS232 port. The receiver requires Flex-

Office or another third-party software.

e The USB device port

e For instruments fitted with a Communication side cover. The USB device can be
connected to the USB device port housed in the Communication side cover. The USB
device requires FlexOffice or another third-party software.

e A USB memory stick
For instruments fitted with a Communication side cover. A USB memory stick can be
inserted and removed from the USB host port housed in the Communication side cover.

No additional software is required for the transfer.

3.2.4.1 Access

e Select Transfer from the Main Menu.

e Select Export.
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3.2.4.2 Export

e Select as shown in the figure. Select-> To - USB stick

Select i

To ; USB-StickI[]

Data Type Measurements4[p
Job ; Single Job[4Ip
Select Job : 12341

Back | Search | List | Cont
Fig.3.1 Export window

e The other steps are as shown in the table below:

Table 3.1 Steps during export

Field Description

To USB memory stick or RS232 serial interface

Data Type Data Type to be transferred.
To USB memory stick or RS232 serial interface:
Measurements, Fix points, Measure and Fix points.
Only to USB memory stick: Road Data, Code, Format,
Configuration, Backup

Job Select whether to export all job-related data or a single job data
file.

Select job Displays the selected job or road alignment file.

Format If Data Type: Format.

Select whether to export all formats or single format

Format Name

If Format: Single Format.

Name of the format to be transferred.
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3.2.4.3 Export data step by step

1. Press Cont in the Export screen after selecting the export details.

2. If export is to a USB memory stick, select the desired file location and press Cont

Data type: Default folder on USB memory stick

Job data: Jobs

Format files: Formats

Codes: Codes

3. Select the data format, enter the file name and press Cont or Send. If the data format is ASCI|,
the Define ASCII Export screen appears. Continue with step4. For all other data format types, a
message will display confirming the successful export of data.

4. Define the delimiter value, the units and the data fields of the file and press Cont. A message

will display confirming the successful export of data.

Define ASCII Export | ©
Config. |

Delimiter [ CoinaL
Unit : meter
Incl. Header: No

Data Fields : PtID4lp)] East
North|dlp|Height(4]p)] Code
Info/dlp
Example:PtID,E, N, H, Code, Info
|Default| | Cont

Fig.3.2 ASCII Export Window

|| |
v v |v|Y

5. Job data can be exported from a job in dxf, gsi, csv and xml file types, or any other user-

defined ASCII format.

3.3 DGPS

DGPS is an advanced version or the enhancement to Global positioning System (GPS). DGPS can
be achieved through post-processing the data or real-time telemetry links between a base and a
rover. Real-time methods include (a) medium frequency beacon differential service, (b) L-Band

satellite differential service, (c) frequency modulation sub- carrier differential service, (d) on-site,
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radiofrequency telemetry link. All the real-time services have a coverage area and a range
limitation and require a local radio/receiver to obtain the transmitted service. Method requires
operation of a transmitter by the user in addition to the radio/receiver. Post-processing differential
techniques relies on two GPS receivers with storage capacity. The kinematic post-processing
method relies on the base station as the reference receiver and the rover as the unit that can move
around without restriction. The user will post-process the data on a computer after the GPS data
have been collected. Kinematic post processing is the most preferred method of tracking motion
in DGPS when accuracy and precision are a major issue.

Post-processing is used to obtain precise positions of unknown points by relating them to known
points such as survey markers. The GPS measurements are usually stored in computer memory in
the GPS receivers, and are subsequently transferred to a computer running the GPS post-
processing software. The software computes baselines uses simultaneous measurement of data
from two or more GPS receivers. The base line represents a three-dimensional line drawn between
the two points occupied by each pair of GPS antennas. The post-processed measurements allow
more precise positioning because most GPS errors can be cancelled out in calculations as they
effect both receiver more or less equally. Differential GPS measurements can also be computed in
real-time by some GPS receivers if they receive a correction signal using a separate radio

receiver, for example in Real Time Kinematic (RTK) surveying or navigation.

Main features of DGPS survey are:
e Position is determined by distance from at least four satellites.
e Time taken by signal to travel from satellite to antenna is used to determine the distance.
e The base station calculates the difference between the specified coordinates of its location
and those indicated by the satellites.
e The base is continuously broadcasting a signal to the rover of this difference.

e The rover then uses this same difference to accurately determine its location.

GNSS is basically a Global Navigation Satellite System. GNSS includes GPS, GLONASS,
GALILIO and COMPASS satellite systems. The GPS is a US based satellite system which is
having more than 32 satellites and they are available 24 hours. GLONASS is a Russian Satellite
System which is available 24 hours and having around 24 satellite system. Galileo is a European

satellite system and COMPASS is a Chinese Satellite System which is under testing.

There are three types of survey which we can do using GNSS:
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1. Static Survey (Control point establishment)
2. PPK Survey (Post Processed Kinematic Survey)
3. RTK Survey (Real Time Kinematic Survey)

3.3.1 Static Survey
Static Survey is basically used to establish the control points or network in the field. We normally
do Triangulation method for the setting up of control survey as mentioned in below drawing. The

processing of Data will be done in TBC (Trimble Business Center) software.

2 3
Fig. 3.3 Triangulation method for setting up control points

3.3.1.1 Starting Procedure of Static Survey
1. Base Startup:

a. Find a best, safe, secure and open location to setup the base. If possible, find high point place

with open sky.

b. Setup Tripod on Known Base Point mark on field.

c. Mount Tribrach and Prism Base on The Tripod.

d. Mount 2.5 meter Short Pole on the Prism Base.

e. Mount R6 GNSS receiver on the Short Pole and Controller on the Tripod with Fixing Bracket.

f. The Setup should look like below mentioned setup image.
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Plate 3.4 Base setup in static survey

g. Now switch on the R6 GNSS Receiver.

h. Switch on the Controller and Set the local time from Start - Setting - Systems > Clock. After
setting the Clock as per the Country setting (GMT 05:30 New Delhi)

i. To start the Trimble Access software go to Start >Program - Trimble Access.
J. Go to General Survey. You will get six options.
k. After opening this software, just click on the Settings.

I. Go to Survey Style. The setting for the Static survey is as below:
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STATIC SURVEY:

ROVER OPTION Page 1
Survey Type: Fast Static Logging Device: Controller
Logging Interval: 1 Sec Auto File Name:

(If you want to give Auto file name
than correct the check box)

Elevation Mask: 15° | PDOP Mask: 6.0

Page 2

Antenna Type: R6 2 Internal Measured To: Bottom of Antenna
Mount

Antenna Height: 2.00 M

Page 3
Use L2e: V] Use Glonass: ¥

Fig. 3.4 Base settings window for static survey

m. After doing all above setting, accept all the setting and store the survey style settings.

n. Now go to Connect ->Bluetooth > Configuration > click the check box for turning on the
Bluetooth. Select the receiver - Next - Next>OK.

0. Connect the GNSS receiver to Rover 2> R6EXXXXXXX - Accept.
p. Go to Trimble Access—> General Survey—> Jobs—> create New Job.
g. Give Job Name

r. Select the Coordinate System as per the survey location and zone. Also link your Feature

Library if you are using for your survey.

s. Give approximate project height (MSL) of location.

t. Accept to save the changes you made in new job

u. Go to Survey > Static - Start Base Receiver - Give a Base Point Name and Code - Start

v. Now the base will start collecting the data.
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2. Rover Startup:

i. Find a best, safe, secure and open location to setup the Rover.
ii. Setup Bipod on Point mark on field.

iv. Now switch on the R6 GNSS Receiver.

v. Switch on the Controller and Set the local time from Start = Setting - Systems - Clock. After
setting the Clock as per the Country setting (GMT 05:30 New Delhi).

The Setup should look like below mentioned setup image.

Plate 3.5 Rover set up in static survey

vi. Go to General Survey. You will get six options.
vii. To start the Trimble Access software go to Start >Program - Trimble Access
viii. After opening this software, just click on the Settings.

iX. Go to Survey Style. The settings for the Static survey are as below:
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STATIC SURVEY:

ROVER OPTION Page 1
Survey Type: Fast Static Logging Device: Controller
Logging Interval: 1 Sec Auto File Name: &

(If you want to give Auto file name
than correct the check box)

Elevation Mask: 15° PDOP Mask: 6.0

Page 2

Antenna Type: RE 2 Internal Measured To: Boftom of Antenna
Mount

Antenna Height: 2.00 M

Page 3
Use L2e: Use Glonass: &1

Fig. 3.5 Rover settings window in static survey
X. After doing all above setting, accept all the setting and store the survey style settings.

xi.. Now go to Connect > Bluetooth = Configuration > click the check box for turning on the
Bluetooth. Select the receiver - Next - Next->OK.

xii. Connect the GNSS receiver to Rover >R6EXXXXXXX - Accept.

xiii. Go to General Survey. You will get six options.

Xiv. Go to Job ->Create New Job.

xv. Give Job Name

xvi. Select the Coordinate System as per the survey location and zone. Also link your Feature
Library if you are using for your survey.

xvii. Give approximate project height (MSL) of location.

xviii. Accept to save the changes you made in new job

xiX. Go to Survey -> Static > Measure Points - Give a Point Name and Code —> Start
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xX. Now the Rover will start collecting the data. For a good survey keep the rover for %2 to 1 hour

for each control points.

xXi. Repeat the same procedure for different Control Points.

3.3.1.2 Ending the GNSS survey
i. First do the ending of Survey in Rover.

ii. Go to Survey and Select End GNSS Survey. Now exit the Trimble Access software and off the

controller.

iii. Secondly press the end option in Base. Now exit the Trimble Access software and switch off

the controller.

iv. Repeat the all above procedure when you change the base location.

3.3.2 PPK Survey

PPK Survey is called Post Processed Kinematic Survey in which we are doing Topography. After

collecting all the points, we have to do the post processing in software.
3.3.2.1 Startup procedure of PPK Survey
1. Base Setup:

i. Find a best, safe, secure and open location to setup the base. If possible, find high point place

with open sky.

ii. Setup Tripod on Known Base Point mark on field.
iii. Mount Tribrach and Prism Base on The Tripod.
iv. Mount 2.5 meter Short Pole on the Prism Base.

v. Mount R6 GNSS receiver on the Short Pole and Controller on the Tripod with Fixing Bracket.

The Setup should look like below mentioned setup image.
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Plate 3.6 Base setup in PPK survey

vi. Now switch on the R6 GNSS Receiver.

vii. Switch on the Controller and Set the local time from Start - Setting - Systems —>Clock.
After setting the Clock as per the Country setting (GMT 05:30 New Delhi)

viii. To start the Trimble Access software go to Start >Program - Trimble Access.
iX. After opening this software, just click on the Settings.

X. Go to Survey Style. The settings for the PPK survey are as below:
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PPK SURVEY:

BASE OPTION Page 1
Survey Type: PP Kinematic Logging Device: Controller
Logging Interval: 1 Sec Auto File Name: 1

(If you want to give Auto file name
than correct the check box)

Elevation Mask: 15" Antenna Type: R6 2 Internal

Page 2

Measured To: Center of Bumper Antenna Height: (Measured with
Tape)

Page 3

Use L2e: M Use Glonass:

Fig. 3.6 Base settings window in PPK survey

xi. After doing all above setting, accept all the setting and store the survey style settings.

xii. Now go to Connect ->Bluetooth > Configuration -> v Click the check box for turning on the
Bluetooth. Select the receiver - Next - Next>OK.

xiii. Connect the GNSS receiver to Base > R6EXXXXXXX —>Accept.

xiv. Go to General Survey. You will get six options.

xv. Go to Job > Create New Job.

xvi. Give Job Name

xvii. Select the Coordinate System as per the survey location and zone. Also link your Feature
Library if you are using for your survey.

xviii. Give approximate project height (MSL) of location.

xix. Accept to save the changes you made in new job

xX. Go to Survey >PPK - Start Base Receiver - Give a Base Point Name and Code - Start

xxi. Now the base will start collecting the data.
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2. Rover Setup:

i. Find a best, safe, secure and open location to setup the Rover for Initialization.
ii. Setup Bipod on Point mark on field.

iii. Now switch on the R6 GNSS Receiver.

iv. Switch on the Controller and Set the local time from Start - Setting - Systems —>Clock.
After setting the Clock as per the Country setting (GMT 05:30 New Delhi).

The Setup should look like below mentioned setup image.

g .
:

Plate 3.7 Rover setup in PPK survey
v. To start the Trimble Access software go to Start >Program - Trimble Access
vi. After opening this software, just click on the Settings.

vii. Go to Survey Style. The settings for the PPK survey are as below:
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PPK SURVEY:
ROVER OPTION Page 1
Survey Type: PP Kinematic Logging Device: Controller
Logging Interval: 1 Sec Auto File Name:
(If you want to give Auto file name
than correct the check box)
Elevation Mask: 15° PDOP Mask: 6.0
Page 2
Antenna Type: R6 2 Internal Measured To: Bottom of Antenna
Mount
Antenna Height: 2.00 M
Page 3
Use L2e: Use Glonass: ¥
TOPO POINTS
Auto Point Step Size: 1 Quality Control: QC1
Auto Store Point: Occupation Time: 0 M 5 Sec
(Do not Click the Option)
No of Measurements: 15

Fig. 3.7 Rover setting window in PPK survey

viii. After doing all above setting, accept all the setting and store the survey style settings.

iX. Now go to Connect ->Bluetooth > ConfigurationElCIick the check box for turning on the
Bluetooth. Select the receiver - Next - Next->OK.

X. Connect the GNSS receiver to Rover 2> R6EXXXXXXX - Accept.
xi. Go to General Survey. You will get six options.
xii. Go to Job > Create New Job.

xiii. Give Job Name
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xiv. Select the Coordinate System as per the survey location and zone. Also link your Feature

Library if you are using for your survey.

xv. Give approximate project height (MSL) of location.
Xvi. Accept to save the changes you made in new job
xvii. Go to Survey ->PPK —>Measure Points > Esc

xviii. Again Go to Survey ->PPK -> Initialization = Init->New Point - Give a Point Name and
Code ->Start >now wait for 8 min to get the Fixed Solution.

xix. After getting fixed solution just store the point and proceed for Topo Survey.

xX. For Topo Survey again go to Survey ->PPK ->Measure Points > Point Name and Code
—>Measure >Wait till 15 sec - Store the point.

xxi. Now go to next point.

xXii. Repeat the same procedure for different Topo Points.

3.3.2.2 Ending the PPK Survey
. First do the ending of Survey in Rover.

il Go to Survey and Select End GNSS Survey. Now exit the Trimble Access software and off the

controller.

iii. Secondly press the end option in Base. Now exit the Trimble Access software and switch off

the controller.

iv. Repeat the all above procedure when you change the base location.

3.3.2.3. Post process of data in Trimble Business Center

The Data collected in the field are processed in the Trimble Business Center which is office

software. For doing the post process of data the below are the steps.
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1. How to download the data:
i. Open the TBC software and plug the software key to the USB port of computer.

ii. Create a new project. Go to Project >Project Setting = Set all the parameters like company

name, coordinate system, feature code library etc.

e Give company name and feature code if needed.
e To change the co-ordinate system—> select change> UTM - 43 North - OK.

iii. Save all the settings while selecting OK.
iv. Connect the BASE controller to PC. The active sync will connect the instrument.

v. In TBC, the device menu will open. Select the file to download - Just drag the file in software
and select the appropriate geoid model (EGM96 global) - keep the existing co-ordinate > Now
the check in list of base data will appear. Check all data like antenna height and receiver type. Ok

to confirm the download.

vi. Same way connect the rover controller to PC and download the data.

2. How to process the Data:

i. Single click on the BASE point and right click on the point to view properties. Add coordinate

of BASE while pressing® button. Now make the base coordinate as control coordinate.

ii. Now you see will the baseline in the plan view. Go to Select > Select All. Go to Survey

—>Process Baseline.

iii. Now the Baseline processing will start and save the result. After completion of the data, check
the report for fixed solution. For seeing the report - select report icon from main menu-> select

the required type (point list or base line processing) —>save the report in the required form.

iv. To export the point data to CSV/DWG/DC /etc. Go to Menu = Export. Select the format to

export as per your requirement.
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3.3.3 RTK Survey
3.3.3.1 Startup procedure of RTK Survey
1. Base Setup:

I. Find a best, safe, secure and open location to setup the base. If possible, find high point place

with open sky.

ii. Setup Tripod on Known Base Point mark on field.

iii. Mount Tribrach and Prism Base on The Tripod.

Iv. Mount 2.5 meter Short Pole on the Prism Base.

v. Mount R6 GNSS receiver on the Short Pole and Controller on the Tripod with Fixing Bracket.
vi. Connect PDL 450 radio with receiver.

vii. Now switch on the R6 GNSS Receiver.

viii. Switch on the Controller and Set the local time from Start > Setting - Systems > Clock.
After setting the Clock as per the Country setting (GMT 05:30 New Delhi)

ix. To start the Trimble Access software go to Start >Program > Trimble Access
X. After opening this software, just click on the Settings.

Xi. Go to Survey Style. The settings for the RTK survey are as below:
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RTK SURVEY:

BASE OPTION
Page 1
Survey Type: Eeal Time Kinematic | Broadcast Format: CMEx

Station Index: (User Defined) Elevation Mask: 15°

Antenna Type: EE 2 Intemal

Page 2 |

Measured To: Center of Bumper Antenna Height: (Measured with
Tape)

Page 3

Use L2e: & Use Glonass:

BASE RADIO

Page 1

Type: Trimble PDL450 Receiver Port: Port1

Baud Rate:8600

After doing the setting press Connect

Frequancy: 433.025 B Radio E)perating Mode: Base/Rover
Base Radic Mode: L 450 at| Sensitivity: Moderate
9600 bps

Fig. 3.8 Base settings in RTK survey

xii. After doing all above setting, accept all the setting and store the survey style settings.

xiii. Now go to Connect - Bluetooth 9Configuration.|zI Click the check box for turning on the
Bluetooth. Select the receiver =>Next = Next=>OK.

xiii. Connect the GNSS receiver to Base>R6EXXXXXXX-> Accept.
xiv. Go to General Survey. You will get six options.

xv. Go to Job ->Create New Job.

xvi. Give Job Name

xvii. Select the Coordinate System as per the survey location and zone. Also link your Feature

Library if you are using for your survey.
xviii. Give approximate project height (HAE) of location.
Xix. Accept to save the changes you made in new job

xX. Go to Survey >RTK ->Start Base Receiver > Give a Base Point Name and Code—-> Start.
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2. Rover Setup:

i. Find a best, safe, secure and open location to setup the Rover for Initialization.
ii. Setup Bipod on Point mark on field.

iii. Now switch on the R6 GNSS Receiver.

iv. Switch on the Controller and Set the local time from Start-> Setting -—>Systems - Clock.
After setting the Clock as per the Country setting (GMT 05:30 New Delhi).

v. To start the Trimble Access software go to Start->Program - Trimble Access
vi. After opening this software, just click on the Settings.

vii. Go to Survey Style. The settings for the RTK survey are as below:

RTK SURVEY:

ROVER OPTION Page 1

Survey Type: Real Time Kinematic | Broadcast Format: CMRx

Station Index: Any Prompt Station Index: &

Elevation Mask: 15° PDOP Mask: 6.0

Page 2

Antenna Type: RE 2 Internal Measured To: Bottom of Antenna
Mount

Antenna Height: 2.00 M

Page 3

Use L2e: & | Use Glonass: &1

Rover Radio

Type: Trimble Internal | Method: Trimble 450/950

After doing the setting press Connect B

Frequancy:433.025 Base Radio Operating Mode:_TTL 450
at 9600bps

TOPQ POINTS

Auto Point Step Size: 1 Quality Control: QC1 & QC3

Auto Store Point: [ Occupation Time: 0 M 5 Sec

Fig. 3.9 Rover settings in RTK Survey
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viii. After doing all above setting, accept all the setting and store the survey style settings.

iX. Now go to Connect - Bluetooth 9Configuration.|2I Click the check box for turning on the
Bluetooth. Select the receiver > Next—>Next->OK.

X. Connect the GNSS receiver to Rover 2 REXXXXXXX > Accept.
Xi. Go to General Survey. You will get six options.

Xii. Go to Job ->Create New Job.

xiii. Give Job Name

xiv. Select the Coordinate System as per the survey location and zone. Also link your Feature

Library if you are using for your survey.

xv. Give approximate project height (HAE) of location.

Xvi. Accept to save the changes you made in new job

xvii. Go to Survey >RTK ->Measure Points - Esc

xviii. After getting fixed solution just store the point and proceed for Topo Survey.
xix. Measure each point for every 5 sec logging of data.

xx. Now go to next point.

xxi. Repeat the same procedure for different Topo Points.

3.3.3.2 Ending the RTK Survey

i. First do the ending of Survey in Rover.

ii. Go to Survey and Select End GNSS Survey. Now exit the Trimble Access software and off the

controller.

iii. Secondly press the end option in Base. Now exit the Trimble Access software and switch off

the controller.

iv. Repeat the all above procedure when the base location is changed.
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3.4 ArcGIS

ArcGIS is a Geographic Information System (GIS) for working with maps and geographic

information. The system provides an infrastructure for making maps and geographic information

available throughout an organization, across a community, and openly on the web.

It is used for:

Creating and using maps

Compiling geographic data

Analyzing mapped information

Sharing and discovering geographic information

Using maps and geographic information in a range of applications

Managing geographic information in a database
Steps involved during map formation in ArcGIS are:

Excel file input

Disp&y points

Export to shape file

v
TIN

v

1. SLOPE MAP
2. CONTOUR MAP
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ArcMap window is shown in the figure 3.10

File Edit View Bookmarks |Insert Selection Geoprocessing Customize Windows Help

D@8 L8Bx 9 b- MEEEREO R,
RO« E- 0807 BILINGSIEIRY
Editor- | b Ry | S oFt A1 N e th A A s
Table Of Contents B x 2

w“Bo8 =
B Loyers

[saimeas seaio BY| [uniess &l Goreieo & |

gle|2n < >
SN0 AN 742 118 Hnbmosm it

Fig. 3.10 ArcMap window
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RESULTS AND DISCUSSION

Chapter 4

4.1. TOTAL STATION SURVEY RESULTS

4.1.1. Co-ordinates of field data

Total Station data were processed in PC. After processing, co-ordinates of surveyed points were

obtained ie, 419 points. The co-ordinates of some of the points are tabulated in Table4.1.

Table 4.1 Total Station survey data

Point ID Easting (m) Northing (m) Elevation (m)
1 975.062 1000.871 99.7722
2 977.0329 999.504 99.1158
3 974.0394 1011.53 99.7494
4 974.6311 1019.191 100.6057
5 974.0793 1024.98 102.0542
6 968.3189 1032.932 102.6568
7 990.4641 1031.422 102.4094
8 992.462 1021.072 101.9938
9 992.1904 1012.84 100.7373
10 993.172 1001.219 100.0018
11 993.0968 999.7573 99.2124
12 992.6835 996.5233 99.0019
13 992.6579 996.5107 98.9986
14 1008.956 1029.329 102.0371
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15 1008.92 1016.254 101.0573
16 1008.553 1001.649 100.3051
17 1015.828 998.0311 100.2934
18 1007.502 985.6181 99.4944
19 999.3703 980.6228 99.0383
20 972.1819 981.0881 98.8974
21 991.1756 970.1641 98.9677
22 1006.571 969.8031 98.4563
23 1032.925 1014.816 102.1329
24 1032.941 1012.753 101.0007
25 1032.866 1000.463 99.7549
26 1054.558 1010.191 100.8623
21 1005.261 940.0196 96.6313
28 1004.639 928.0462 96.2184
29 1004.931 915.6289 95.514

30 999.7136 915.9408 95.7369
31 991.2148 912.9656 95.5513
32 965.9513 915.1267 95.7604
33 923.772 919.1866 95.3085
34 921.2432 937.6461 95.9716
35 921.1797 948.8388 96.509

36 926.6654 961.725 96.3817
37 964.7083 943.2336 96.0598
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38 966.1101 956.0936 96.3006
39 991.4049 953.5079 96.29

40 990.1599 943.4791 96.2224
41 989.1541 922.1144 95.6836
42 1014.316 953.8418 97.4759
43 1009.934 960.0128 97.7201
44 1010.84 927.8311 96.264
45 1016.433 911.333 96.3793
46 930.7034 965.235 97.943
47 1025.522 916.9516 96.3526
48 1034.714 921.8979 96.6987
49 1040.144 909.7098 96.1863
50 1062.257 908.1539 96.5619
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4.1.2 Map preparation in ArcGIS software

Using ArcGIS software, points were plotted and from that plot different DEM’s and contour map

of the area were created. Distribution of points surveyed by TS is shown in Fig. 4.1.
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Fig. 4.1 Points surveyed on the uplands of KCAET campus

419 points were surveyed over an area of 15 ha. The points were observed in such a manner that
more points were collected in regions with more undulating topography where as in a plane area
the spacing of points were farther. Most closely spaced points were taken near the South-West
boundary point where as the least number of points with more spacing was taken in the main

ground which is one of the plane areas of KCAET campus.

TIN (Triangulated Irregular Network) was generated using ArcGIS. TIN is the vector-based
representation of the physical land surface, made up of irregularly distributed lines with 3D
coordinates(x, y, and z) that are arranged in a network of nonoverlapping triangles. The Fig.

4.2.shows the TIN generated.
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Triangulated Irregular Network (TIN) of the study area ‘
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Fig. 4.2 TIN of the study area

From the Figure 4.2, it can be noted that in regions where there is little variation in elevation, the
points were widely spaced whereas in areas of more intense variation in elevation the point
density was more. The regions with high elevation are shown in red colour in this TIN map. It has
an elevation ranging between 101.989m to 104.593m. The lowest elevation points of surveyed

area were in between 81.155m and 83.76m. It is shown in pink colour in the TIN map.

Contour map plotted using ArcGIS in which contour lines represents points of equal elevation
(height) above a given level (arbitrary datum, mean sea level etc). A contour interval of 1m has

been chosen. Fig. 4.3 shows the contour map of the area surveyed using Total Station.
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Contour map of the study area )

M2 oqpr

s L

_es

D 37575 150 225 300
I N icters

Fig. 4.3 Contour map of the study area

In this contour map, the innermost loop shows the highest elevation area where as the outermost
loop shows the lowest elevation area. In this contour map, the contour line having 104m is the

highest point and that with 82m is the lowest point.

Slope map was created from the surveyed points and is shown in figure 4.4. A slope map is a map
displaying the topography of the area, along with discussion of the topographic features. The
region with higher slope is represented by dark coloured patches which range between 7.0 to 9.0
%, whereas regions with lowest slope are shown by light coloured patches. It ranges between 1.0

t0 2.0 %.

48



Slope map of the study area F
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Fig. 4.4 slope map of the study area

Areas having slope less than 2% requires only ordinary management practices to maintain their
level of productivity. Overland flow is the main problems faced by those areas. Pastures can be
maintained and cover crops can be adopted for reducing overland flow. Areas having slope
between 2 to 5% is more susceptible to water erosion, frequent surface runoff accompanied with
crop damage. Strip cropping, contour bunding, cover cropping and water disposal can be adopted
for the conservation of fertile top soil. Areas having 5 to 10% slopes are having steep slopes and

are more susceptible to erosion. Careful management practices are required in this area.

Major problem faced by KCAET at present is its acute water shortage in summer. Construction of
recharge pits and percolation ponds in regions of lower elevation can help to solve this problem. It
helps to recharge the ground water table.
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4.2 GNSS SURVEY RESULTS

Post processing of data collected by DGPS was done by Trimble Business Center software.

Distribution of points on the area is shown in the figure 4.3 and point list is given in the table 4.2.
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Fig. 4.5 Point plotted using GNSS

In this figure two base stations are shown in triangular symbols. With respect to Base b1, 181
points are surveyed and 69 points were surveyed with respect to base b2. In the above figure

unprocessed data is shown.
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Table 4.2 GNSS survey data

ID Easting Northing Elevation
(Meter) (Meter) (Meter)
b1 607783.271 1199926.638 28.176
b2 607774.330 1199795.692 21.022
rov 607777.959 1199933.607 28.303
rov2 607827.434 1199776.656 20.168
rov3 607821.112 1199776.553 23.640
rov4 607827.581 1199782.981 24.413
rovs 607832.428 1199775.195 20.830
rove 607836.639 1199784.338 24.224
rov7 607864.142 1199775.090 20.672
rov8 607855.648 1199786.419 21.213
rov9 607861.762 1199774.743 20.594
rov10 607892.910 1199785.194 21.306

The Horizontal precision, Vertical precision, Geodetic azimuth etc, can be obtained from the

processing summary. The processing summary of some of the points are given in the table 4.3.

Table 4.3 Processing Summary

Observation From To Solution Type | H. Prec. V.Prec. | Geodetic | Ellipsoid | AHeight
(Meter) (Meter) Az. Dist. (Meter)
(Meter)
rovl (B1) b1 rov1 Fixed 0.005 0.011] 322°52'11" 8.765 0.126
rov2 (B2) b1 rov2 Fixed 0.035 0.058] 163°46'42"|  156.389 -8.007
rov5 (B5) b1 rovs Fixed 0.054 0.093] 162°12'10"|  159.262 -7.346
rov7 (B7) b1 rov7 Fixed 0.023 0.031] 152°05'59"  171.820 -7.503
rov8 (B8) b1 rov8 Fixed 0.024 0.030] 152°53'03"|  157.837 -6.962
rovd (B9) b1 rov9 Fixed 0.036 0.037] 152°51'30"  171.020 -1.581
rov10 (B10) b1 rov10 Fixed 0.026 0.031] 142°24'19"|  179.007 -6.869
rov11 (B11) b1 rov11 Fixed 0.025 0.032] 142°4116"|  184.923 -7.083
rovi2 (B12) b1 rov12 Fixed 0.049 0.052 143°5013"]  182.582 -7.050
rov14 (B14) b1 rovi4 Fixed 0.035 0.040] 138°44'48"|  172.311 -6.412

Here, Geodetic azimuth refers to a vector measured from true north at any given point on the
earth. If field is set to ellipsoid then a correction is applied and all distances are calculated as if on

the local ellipsoid which is called ellipsoid distance.
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Vector components of rover points with respect to base station is shown in the table 4.4

Table 4.4 Vector components of rover points

From: b1

Grid Local Global
Easting 807783.271 m Latitude N10°51'11.65719" Latitude N10°51'11.65719"
Northing 1199926.638 m Longitude E75°59'09.96007" Longitude E75°58'09.96007"
Elevation 28.176 m Height -63.975 m Height -63.975m
To: rov1

Grid Local Global
Easting 807777.959 m Latitude N10°51'11.88461" Latitude N10°51'11.88461"
Northing 1199933.607 m Longitude E75°59'09.78588" Longitude E75°58'09.78588"
Elevation 28.303 m Height -63.849 m Height -63.849 m
Vector
AEasting -5.312 m NS Fwd Azimuth 322°52'"11" AX 4.845m
ANorthing 6.969 m Ellipsoid Dist. 8.765 m AY -2.437m
AElevation 0.126 m AHeight 0.126 m AZ 6.887 m

In Trimble business center, Global latitude or longitude heights are in terms of a “Global co-
ordinate datum” which in most modern cases is synonymous with the WGS84 datum. A Global

co-ordinate datum is an approximation of the entire globe.

Local latitude or longitude heights are in terms of a “Local co-ordinate datum” which is a datum
that is a regional best fit, rather than a global best fit. An example for local co-ordinate datum is

Australian Geodetic Datum.
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Chapter 5

SUMMARY AND CONCLUSIONS

The main purpose of this project work is to prepare the topographic map of upland regions of
KCAET campus. The topographic map is very important while planning for agricultural
infrastructures and for soil and water conservation studies. For this purpose, the main equipments
used were Total Station and DGPS. During this project the principles and working of Total
Station and DGPS were studied. Using Total Station, upland areas of KCAET campus were
surveyed and the coordinates of 419 points were taken. Using the field collected data, a
topographic map was plotted using arcGIS10.3 software. Total Station data lacks geographic
coordinates and this give rise to difficulty plotting the data using GIS software. Using the field
collected data three maps were generated: TIN, contour map and slope map. GNSS was also
adopted for surveying the same area. But due to the dense canopy of the plot, the survey was
further confined to the open areas of the study area. During the GNSS survey two base points
were taken and with respect to this 250 points were surveyed. Post process kinematic survey was
adopted for this. These points were post processed in PC using Trimble Business Centre Software.
Due to some inevitable reasons maps for this survey could not be made. The processed reports
were exported to the required file format. The data of the base line report helped in knowing the
longitude, latitude, elevation, easting and northing and other details of the point. Geographical
coordinates taken by GNSS were used during plotting maps of Total station collected field
coordinates in ArcGIS.

From this project, it can be concluded that Total station and DGPS are two efficient equipments
that can be used for surveying in a short span of time in a more accurate manner. Even though the
use of TSS reduces the manual errors involved, it has limitations regarding the visibility and lacks
references of geographical co-ordinates. In the case of DGPS, the measurements of points more
fast and gave more precise data than TSS. DGPS can cover wider areas than of TSS but shows
limitations in places with dense canopy and is weather dependent. In Kerala terrain, working with
DGPS alone does not give good results whereas that in combination with TSS give better and
satisfactory results. A map with good accuracy and great speed could be generated. Contour map
can be made interactive to accommodate various engineering planning requirements. TIN has
been generated using the co-ordinates of TSS and it can act as a prerequisite for generating

customized maps such as degree of slope, aspect, slope curvature, contour etc. A slope map was
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prepared from data collected using TSS. From the slope map, it was known that the highest slope
of the area ranges between 7.0 to 9.0 % and lowest slope ranges between 1.0 to 2.0%. Based on

the slope ranges obtained, various conservation measures for the area can be planned adopted.
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Appendix I

Point list of Total Station survey

Point ID Easting (m) Northing (m)  Elevation (m)

1 975.062 1000.871 99.7722

2 977.0329 999.504 99.1158

3 974.0394 1011.53 99.7494
4 974.6311 1019.191 100.6057
5 974.0793 1024.98 102.0542
6 968.3189 1032.932 102.6568
7 990.4641 1031.422 102.4094
8 992.462 1021.072 101.9938
9 992.1904 1012.84 100.7373
10 993.172 1001.219 100.0018
11 993.0968 999.7573 99.2124
12 992.6835 996.5233 99.0019

13 992.6579 996.5107 98.9986

14 1008.956 1029.329 102.0371
15 1008.92 1016.254 101.0573
16 1008.553 1001.649 100.3051
17 1015.828 998.0311 100.2934
18 1007.502 985.6181 99.4944
19 999.3703 980.6228 99.0383

20 972.1819 981.0881 98.8974
21 991.1756 970.1641 98.9677

22 1006.571 969.8031 98.4563

23 1032.925 1014.816 102.1329
24 1032.941 1012.753 101.0007
25 1032.866 1000.463 99.7549

26 1054.558 1010.191 100.8623
27 1005.261 940.0196 96.6313

28 1004.639 928.0462 96.2184
29 1004.931 915.6289 95.514
30 999.7136 915.9408 95.7369
31 991.2148 912.9656 95.5513
32 965.9513 915.1267 95.7604
33 923.772 919.1866 95.3085
34 921.2432 937.6461 95.9716
35 921.1797 948.8388 96.509

w
(o]

926.6654 961.725 96.3817




37
38
39
40
41
42
43
44
45
46
47
48
49
50
51
52
53
54
55
56
57
58
59
60
61
62
63
64
65
66
67
68
69
70
71
72
73
74
75
76
77
78

964.7083
966.1101
991.4049
990.1599
989.1541
1014.316
1009.934
1010.84
1016.433
930.7034
1025.522
1034.714
1040.144
1062.257
1080.291
1068.851
1074.095
1085.165
1099.013
1114.222
1085.85
1079.193
1086.974
1078.716
1079.662
1089.045
1080.117
1080.191
1078.048
1061.015
1072.198
1060.828
1066.031
1077.205
1087.459
1090.614
1090.737
1087.846
1101.684
1114.954
1128.46
1084.029

943.2336
956.0936
953.5079
943.4791
922.1144
953.8418
960.0128
927.8311
911.333
965.235
916.9516
921.8979
909.7098
908.1539
919.7321
910.7459
910.5085
906.6182
905.6862
920.344
921.3513
937.7607
949.779
955.2477
980.7917
1000.108
1005.504
1019.199
1031.389
1016.132
1013.927
1026.722
1038.591
1042.749
1030.165
1035.174
1038.692
1044.049
1020.97
1020.215
1017.191
1095.015

96.0598
96.3006
96.29
96.2224
95.6836
97.4759
97.7201
96.264
96.3793
97.943
96.3526
96.6987
96.1863
96.5619
96.8602
96.6878
96.5944
96.5559
96.4812
96.8778
97.0728
97.8848
98.4894
98.5234
99.345
100.7301
100.4919
100.9005
101.3275
100.9432
100.6755
101.9066
101.8311
101.6596
101.2654
101.4422
101.4815
101.5215
100.8294
100.7923
100.3879
102.2366




79
80
81
82
83
84
85
86
87
88
89
90
91
92
93
94
95
96
97
98
99
100
101
102
103
104
105
106
107
108
109
110
111
112
113
114
115
116
117
118
119
120

1080.327
1142.711
1140.98
1142.38
1144.341
1146.339
1146.716
1143.878
1143.013
1145.974
1151.97
1188.894
1169.457
1190.223
1192.972
1199.264
1190.218
1187.271
12151
1215.148
1210.19
1208.173
1194.967
1217.453
1228.328
1242.549
1242.519
1227.339
1253.126
1252.383
1246.165
1249.831
1261.706
1278.385
1289.183
1312.961
1312.867
1282.007
1289.642
1284.303
1289.727
1285.101

919.7311
915.5732
947.6503
963.9724
963.8728
963.7804
945.446
943.8853
934.9959
929.291
902.3049
913.493
900.4347
925.1655
939.4202
921.3787
917.0629
896.4787
890.4586
890.4535
907.8398
902.9434
909.2152
897.9634
899.1267
886.7185
886.6958
893.0984
898.5378
887.6967
882.0487
881.2417
886.8806
882.859
880.3412
869.3002
872.4794
902.1927
923.4183
924.2948
929.9494
930.5772

97.0468
96.6388
98.3502
98.416
98.3849
98.3982
97.8475
97.8217
97.3892
96.9481
96.0294
95.7249
95.766
96.7326
96.6386
95.7826
96.0144
94.7805
93.906
93.9358
95.031
94.8727
95.4202
94.4263
94.0813
93.1946
93.1977
93.7492
94.0461
92.925
92.392
92.3593
92.4433
92.066
91.9949
90.7337
90.6715
93.1156
93.7068
94.5594
945117
94.6743




121
122
123
124
125
126
127
128
129
130
131
132
133
134
135
136
137
138
139
140
141
142
143
144
145
146
147
148
149
150
151
152
153
154
155
156
157
158
159
160
161
162

1287.197
1306.45
1306.781
1281.452
1269.975
1253.058
1242.63
1221.666
1226.681
1253.298
1255.185
1265.788
1279.836
1258.98
1282.337
1303.304
1304.435
1304.899
1270.986
1280.148
1295.132
1297.906
1269.785
1273.699
1261.401
1246.294
1230.29
1218.56
1230.138
1241.149
1242.767
1252.876
1261.623
1247.859
1249.829
1253.346
1255.42
1254.96
1260.5
1268.274
1294.471
1296.541

949.5113
946.6497
952.355
926.894
926.8153
928.4307
925.9556
925.7353
945.298
942.7824
944.554
945.1821
945.8211
978.2322
971.5386
971.074
981.2864
981.8772
983.1151
983.6896
988.2204
1007.993
1012.029
1031.294
1003.711
1004.107
1004.671
1021.347
1032.249
1023.721
1023.865
1025.989
1028.545
1035.492
1034.968
1041.34
1045.184
1052.766
1052.648
1052.829
1051.221
1030.043

94.3554
94.1461
93.9144
94.5889
94.7165
95.2583
95.7617
96.161
96.098
95.7278
95.2355
94.8869
94.6912
95.1515
94.2705
93.5094
93.4182
92.953
94.5059
94.0215
93.2481
92.7092
94.0864
93.6093
94.9403
95.218
95.8762
96.9065
95.9194
95.7191
95.3091
94.0872
93.9458
94.9324
94.5145
94.5789
93.9278
94.8709
94.0085
93.4128
92.3664
92.3288




163
164
165
166
167
168
169
170
171
172
173
174
175
176
177
178
179
180
181
182
183
184
185
186
187
188
189
190
191
192
193
194
195
196
197
198
199
200
201
202
203
204

1296.423
1252.107
1235.737
1231.241
1262.664
1251.757
1248.964
1223.049
1211.466
1198.659
1182.465
1188.433
1194.124
1193.834
1197.88
1202.245
1189.829
1153.933
1171.107
1178.114
1192.269
1195.029
1202.625
1211.763
1215.083
1221.525
1237.072
1244.734
1212.481
1222.064
1195.123
1183.423
1180.903
1173.523
1167.017
1146.362
1125.595
1176.403
1180.549
1180.028
1095.515
1107.973

1014.171
1065.125
1069.756
987.9767
984.2068
971.3629
966.5751
957.7233
976.1976
971.2428
978.2984
980.1895
982.107
988.2788
1001.096
1008.868
1018.681
1008.194
1015.215
1030.798
1033.603
1055.961
1075.482
1030.114
1062.627
1069.593
1074.535
1072.883
1075.802
1074.218
1077.432
1081.142
1083.871
1086.564
1086.619
1087.362
1088.222
1087.436
1065.446
1050.084
1092.76
1089.051

92.5787
94.8003
96.6574
96.0091
94.9585
95,5112
95.5666
96.0515
96.6381
97.1726
97.8519
97.501
97.7066
97.7187
97.8441
97.8022
98.8252
99.3728
99.5022
99.4335
98.5665
98.5769
98.4137
97.6722
97.679
97.3128
96.6234
96.0829
98.2442
97.3608
98.4728
98.7892
98.6476
98.9418
99.2804
100.1388
100.5927
98.7748
99.3094
99.8159
101.3592
100.9009




205
206
207
208
209
210
211
212
213
214
215
216
217
218
219
220
221
222
223
224
225
226
227
228
229
230
231
232
233
234
235
236
237
238
239
240
241
242
243
244
245
246

1099.425
1087.163
1081.226
1082.57
1093.449
1056.793
1063.427
1070.541
1081.316
1079.281
1061.785
1066.421
1076.021
1077.319
1056.826
1060.496
1045.222
1065.31
1055.635
1038.313
1037.007
1034.45
1024.125
1019.107
1015.393
999.2072
1002.259
1001.664
1003.829
1003.944
1014.282
1010.715
1014.776
1014.947
1000.96
999.6146
1007.163
1007.449
997.8885
992.8207
983.2191
972.6261

1079.628
1072.246
1075.686
1089.037
1097.418
1100.116
1092.089
1091.77
1106.311
1111.924
1112.65
1108.292
1110.387
1096.048
1117.002
1129.989
1119.733
1100.24
1116.579
1117.485
1107.256
1098.464
1100.714
1108
1115.874
1107.68
1104.178
1094.471
1091.701
1094.391
1109.158
1076.348
1081.128
1085.056
1083.244
1056.127
1046.897
1041.884
1036.155
1052.716
1053.29
1068.421

100.5204
101.5899
102.0724
102.1232
100.8218
103.2686
103.1318
102.7294
102.116
102.1699
103.7694
103.411
102.6729
102.3864
103.7629
103.4667
104.0041
103.1406
103.7449
104.1942
103.7852
104.2092
104.3413
104.2584
104.291
104.565
104.4304
104.416
104.5933
104.394
104.287
103.9634
104.0959
104.2008
103.8422
103.721
103.1273
102.896
102.2988
103.0262
103.0403
103.3949




247
248
249
250
251
252
253
254
255
256
257
258
259
260
261
262
263
264
265
266
267
268
269
270
271
272
273
274
275
276
277
278
279
280
281
282
283
284
285
286
287
288

983.6962
978.1662
950.2321
945.5815
983.3696
967.8456
969.5869
967.7805
1299.752
1303.305
1311.815
1312.594
1321.356
1326.525
1336.126
1347.748
1353.661
1355.771
1350.129
1364.047
1367.983
1364.849
1363.712
1359.723
1362.438
1379.243
1369.987
1380.054
1381.845
1357.413
1354.868
1378.19
1391.57
1395.418
1395.396
1399.369
1376.096
1376.096
976.3211
999.975
970.9493
960.311

1065.423
1078.955
1070.513
1061.851
1100.081
1109.915
1095.005
1122.834
990.0238
958.775
962.4448
955.2722
951.6119
955.2075
953.7071
951.7385
951.5557
950.8839
949.1533
945.8379
944.979
948.8154
950.5013
954.4658
957.8952
966.2338
955.2266
955.4378
951.6798
973.5167
989.7438
988.2782
977.7797
933.0267
933.0303
949.9283
1010.333
1010.352
1105.425
1118.436
1120.049
1115.628

103.4611
103.9512
103.4604
103.4387
104.3545
104.1181
103.7698
103.5067
93.0601
93.5328
92.702
92.7313
92.3689
91.5692
90.9658
89.7975
88.5691
88.299
90.0637
88.7237
88.4255
87.7209
87.3868
87.1853
85.5205
83.7066
85.2348
84.3731
84.0628
84.3957
84.605
83.2851
82.4273
84.8196
84.8194
83.397
83.155
83.0049
104.4716
104.27
103.8613
103.6117




289
290
291
292
293
294
295
296
297
298
299
300
301
302
303
304
305
306
307
308
309
310
311
312
313
314
315
316
317
318
319
320
321
322
323
324
325
326
327
328
329
330

960.0153
945.1942
936.8991
922.3655
920.8027
921.9966
921.4624
918.0904
902.0573
918.7476
916.0774
915.4536
914.4413
896.7661
812.1253
812.0627
843.3899
855.9715
860.0053
861.9471
810.1459
868.1001
859.5164
855.281
808.309
844.0039
876.1484
881.3537
879.3023
909.5865
884.2764
868.4546
814.8575
881.139
929.1576
891.524
880.8922
886.026
885.2819
888.3608
888.3883
895.6548

1120.728
1121.141
1110.38
1122.285
1123.909
1118.304
1103.419
1098.308
1106.334
1075.699
1077.494
1070.758
1060.437
1123.137
1121.194
1121.169
1122.18
1123.343
1120.086
1134.885
1083.185
1099.339
1100.769
1090.638
1033.92
1026.647
1031.338
1045.544
1042.695
1030.198
1037.423
969.9424
961.8519
980.4099
966.3976
996.0498
961.0202
960.1762
941.3897
921.8635
921.868
948.8696

103.3487
102.8611
103.2515
102.2931
102.1276
102.3438
103.1806
102.571
101.578
102.7909
102.6883
102.7433
102.4298
101.4533
98.8317
98.7411
99.0867
100.0144
99.8191
99.9329
98.888
100.1756
99.8067
99.6278
98.7185
98.7163
99.115
101.2899
99.383
101.2563
100.8417
98.1971
97.952
97.9962
97.7883
98.4515
96.8731
96.6039
95.985
95.6615
95.261
96.1177




331
332
333
334
335
336
337
338
339
340
341
342
343
344
345
346
347
348
349
350
351
352
353
354
355
356
357
358
359
360
361
362
363
364
365
366
367
368
369
370
371
372

906.2129
815.0934
978.6796
965.2971
965.9202
938.3613
941.0056
943.6996
919.5766
915.3781
916.3219
1389.818
1389.325
1391.348
1385.173
1393.239
1393.306
1381.08
1379.886
1355.956
1353.273
1348.341
1344.693
1343.305
1340.754
1337.164
1366.131
1368.227
1374.522
1372.924
1364.919
1362.297
1366.764
1375.755
1385.216
1395.997
1392.205
1371.193
1337.499
1328.118
1320.332
1313.537

982.1105
961.695
1024.235
1026.651
1018.063
1030.173
1036.149
1034.022
1028.096
1035.66
1021.977
989.1596
995.3007
996.0058
999.2592
1020.061
1022.506
1017.043
1017.191
1006.004
1004.946
1005.327
1004.374
1003.057
1005.397
1004.889
997.3446
997.8823
999.1402
992.4128
1025.047
1028.579
1039.668
1036.789
1053.626
1061.685
1049.738
1060.59
997.5271
999.831
996.906
993.4727

98.2745
97.9933
101.8381
101.6406
100.4444
102.3289
102.3804
102.2846
101.1611
101.8035
100.5964
82.1292
81.9859
81.1553
82.0255
82.0439
82.0907
82.5152
83.0737
84.2785
84.7869
86.369
87.9158
89.13
89.2781
89.4102
83.9363
83.2838
83.0916
83.4462
83.6123
84.4638
83.611
82.9736
82.9636
82.8019
82.9078
83.3153
89.6728
90.26
90.9299
91.6093




373
374
375
376
377
378
379
380
381
382
383
384
385
386
387
388
389
390
391
392
393
394
395
396
397
398
399
400
401
402
403
404
405
406
407
408
409
410
411
412
413

1305.277
1328.696
1333.516
1325.34
1340.22
1360.573
1350.471
1335.228
1301.63
1312.163
1304.223
1313.834
1326.574
1332.227
1345.922
1351.804
1359.905
1367.565
1359.667
1315.978
838.8997
815.3795
814.9577
814.7227
816.0934
801.3023
801.4287
811.3224
818.182
816.746
815.7022
860.8908
839.1092
838.8253
840.0604
839.8286
840.7281
840.0494
860.4612
860.8182
860.7221

989.7813
1014.211
1041.318
1041.179
1041.629
1044.25
1048.453
1045.636
1037.155
1027.442
1065.652
1056.324
1057.54
1069.739
1070.263
1069.641
1069.579
1068.884
1097.829
1067.505
952.5982
947.2219
945.159
943.4722
937.9006
929.9479
931.7091
933.0833
928.4389
933.163
942.5782
947.7612
945.7499
942.3269
940.7464
937.85
926.5197
936.0252
944.1317
942.0644
940.6428

92.3844
89.7476
89.9121
90.2929
88.9643
87.9767
88.5037
89.5359
91.6074
90.8555
91.3896
90.7581
90.1813
90.0067
89.7743
88.4463
87.514
87.4118
90.0997
90.5417
98.0051
97.8878
97.2485
96.79
95.1749
94.9499
94.9969
94.9688
94.7325
94.7058
96.3376
97.9463
97.8771
96.9215
96.3868
96.1896
95.0571
95.4496
97.8458
97.2046
96.758




414 860.6294 940.1618 97.01
415 860.4579 938.4994 96.516
416 859.8057 936.6509 95.8147
417 859.2034 930.6166 95.3988
418 859.3981 929.9581 95.0152
419 858.1533 924.5763 95.0506
Appendix 11
Point list of GNSS survey
Point ID Easting (m)  Northing (m) Elevation (m)

bl 607783.271 1199926.638 28.176

b2 607774.330 1199795.692 21.022
rovl 607777.959 1199933.607 28.303
rov2 607827.434 1199776.656 30.168
rov3 607821.112 1199776.553 23.640
rov4 607827.581 1199782.981 24.413
rovs 607832.428 1199775.195 20.830
rové 607836.639 1199784.338 240224
rov7 607864.142 1199775.090 20.672
rovs 607855.648 1199786.419 21.213
rov9 607861.762 1199774.743 20.594
rov10 607892.910 1199785.194 21.306
rovlil 607895.811 1199779.962 21.092
rovi2 607891.459 1199779.620 21.125
rovi3 607892.545 1199799.389 25.296
rov14 607897.281 1199797.496 21.763
rov1s 607905.738 1199791.854 21.496
rov16 607905.752 1199785.507 21.329
rovl/ 607907.717 1199777.467 21.123
rovli8 607919.227 1199777.683 21.044
rov19 607930.683 1199787.714 21.257




rov20
rov21l
rov22
rov23
rov24
rov25
rov26
rov27
rov28
rov29
rov30
rov3l
rov32
rov33
rov34
rov35
rov36
rov37
rov38
rov39
rov40
rov4l
rov42
rov43
rov44
rov4s
rov46
rova47
rov48
rov49
rovs0

rovs1l

607934.612
607961.294
607959.932
607965.210
607983.097
607989.039
607987.414
607991.565
608010.295
608010.792
608011.475
608012.703
608034.530
608033.139
608031.366
608031.727
608049.162
608068.903
608071.165
608074.246
607996.257
608000.318
607993.432
607958.274
607952.088
607950.744
607929.453
607897.180
607903.789
607895.421
607895.695
607893.455

1199794.133
1199780.130
1199792.366
1199796.700
1199792.155
1199781.338
1199783.114
1199793.896
1199793.738
1199801.318
1199789.816
1199779.154
1199796.694
1199794.045
1199788.715
1199777.119
1199788.631
1199780.796
1199773.714
1199773.882
1199826.312
1199820.292
1199813.119
1199824.548
1199822.239
1199814.302
1199810.210
1199818.878
1199821.331
1199824.665
1199835.457
1199850.395

21.478
20.490
20.953
20.877
20.619
19.926
24.266
24.329
20.065
20.466
19.558
19.098
19.533
23.678
23.317
18.591
23.045
20.382
20.336
20.275
23.380
21.274
21.085
22.590
26.011
24.479
25.265
22.791
25.000
23.001
25.013
23.833




rovs2
rovs3
rovo4
rovss
rovs6
rovs/7
rovs8
rovs9
rove0
rov6l
rov62
rove3
rove4
roves
rov66
rove7
roves
rove9
rov70
rov71
rov72
rov73
rov74
rov7s
rov76
rov77
rov78
rov79
rov80
rov8l
rov82

rov83

607900.050
607890.841
607868.061
607865.857
607869.551
607874.721
607885.901
607887.554
607883.758
607877.466
607886.678
607883.379
607896.338
607875.053
607866.160
607856.888
607858.259
607859.652
607865.485
607866.966
607875.441
607877.136
607878.026
607881.791
607878.894
607875.790
607866.837
607854.363
607836.519
607833.487
607821.543
607836.744

1199871.477
1199875.417
1199884.393
1199879.561
1199887.228
1199892.213
1199893.572
1199905.258
1199912.000
1199907.622
1199926.080
1199958.806
1199964.194
1199960.127
1199967.901
1199967.580
1199979.935
1199975.184
1199971.100
1199974.100
1199978.711
1199972.969
1199963.348
1199963.608
1199981.102
1199984.562
1199985.219
1199984.013
1199992.131
1199982.192
1199981.514
1199973.518

27.648
29.130
28.612
26.644
29.780
30.814
30.185
30.470
30.255
30.296
31.170
31.163
30.801
31.623
31.960
32.105
32.424
31.964
27.677
27.718
27.000
26.880
26.745
26.649
30.395
30.390
31.147
31.814
31.342
32.011
31.387
31.196




rovg4
rov8s
rov86
rov87
rov8s
rov89
rova0
rovol
rov92
rov93
rovo4
rovos
rovoe
rov97
rovo8
rov99
rov100
rovi01
rov102
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ABSTRACT

Topographic map is of great importance for the professional activities of an Agricultural Engineer.
This map is an important prerequisite for soil and water conservation planning, design and planning
of irrigation and drainage networks, farm infrastructure and other developments in agricultural field.
This project work mainly focused on the preparation of topographic map of upland regions of
KCAET, Tavanur using modern surveying equipments such as Total Station (LeicaTS06) and DGPS
(Trimble). Using the field collected data from Total Station, a topographic map was plotted using
ArcGI1S10.3 software. TIN, contour map, and slope map were generated from this topographic map.
In GNSS survey, post-process kinematic survey method was adopted. Post- processing of field
collected data was done in Trimble Business Center software. The base line report obtained by
exporting the data from the software provides the longitude, latitude, elevation, easting and northings
etc. of the field point. It was found that,in Kerala terrain (with dense canopy) working with DGPS
alone does not give good result whereas, in combination with TSS gives better and more satisfactory
results. A contour map and slope map with good accuracy and great speed were generated and they

can be used to accommodate various engineering planning requirements.



